Windows Files and Folders Overview

Understanding Files and Folders

Before | get into Windows XP's method of file management, let's spend a little space on a files-and-folder refresher
course. (Just in case you forgot, of course.)

The files and folders on your computer are like the files and folders in a typical filing cabinet. Your computer is the filing
cabinet, and it contains folders that contain individual files.

On your computer, every file and folder has a unique name and occupies a distinct location. A filename consists of a
main name and a three character "extension," separated by a period. A typical filename looks something like this: main
name of this file.ext.

Extensions are typically identified with specific types of files. For example, Microsoft Word documents have a .doc
extension. Whenever you see a file ending in .doc, you know it's a Word document.

TIP

Prior to Windows 95, filenames were limited to eight main characters plus a three-character extension. Windows no
longer has this "8+3" limitation. Filenames can now include up to 255 characters, and can use spaces and special
characters.

Files are stored on your disk in folders. A folder can contain both files and additional folders. (A folder within a folder is
called a subfolder.)

The exact location of a file is called its path and contains all the folders leading to the file. For example, a file named
filename.doc that exists in the system folder that is contained in the windows folder on your c:\ drive has a path that
looks like this: c:\windows)\ system\filename.doc

TIP
What current versions of Windows call "folders," Windows 3.x and MS-DOS called "directories." Some older computer
users—Ilike me—occasionally slip and refer to folders as directories. Don't get confused. A folder and a directory are the

same thing.

Learning how to use files and folders is a necessary skill for all computer users. You may need to copy files from one
folder to another, or from your hard disk to a floppy disk. You certainly need to delete files every now and then.

Any time you have to work directly with files or folders, you use one of Windows XP's file-management tools or upper-
level Windows folders. | show you how to use each of these tools in the next section.

Windows XP's File Management Tools

All the key file management tools in Windows XP look and work very similarly. Whether you're using My Computer or My
Documents (or any other system folder), everything looks and works pretty much the same. It's like you have a single
tool with multiple interfaces—and each interface is customized for its own particular task!
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My Computer

The main file-management tool in Windows XP is My Computer. You can open My Computer from its desktop icon or
from the Start menu.

My Computer lets you manage your hard drive(s), mapped network drives, peripheral drives, folders, and files. As you
can see in Figure 3.1, Windows XP's version of My Computer looks quite a bit different from the My Computer in
previous versions of Windows.

Figure 3.1 Use My Computer to access all the devices attached to your system.
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By default, all the devices on your computer are displayed, and arranged by type in the right pane. The left pane is the
activity center that displays core Tasks, a list of Other Places (other file management tools), and Details about a selected
item.

TIP

You can adjust the width of the activity center pane by grabbing the right edge of the pane with your mouse and
dragging it to resize.

You can open any device, drive, or folder by clicking its icon. When you open an item, its contents are displayed in the
right pane.

When you hover your cursor over an icon, My Computer displays details about that item in the Details section of the
activity center. The Tasks list also changes to reflect tasks specific to the selected item.
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The toolbar at the top of My Computer is the same one displayed in all Windows XP's file management tools. From this
toolbar you can perform the following operations:

e  Go Back to the last item you were looking at

e  Go Forward to the next item

e  Go Up one level in the folder hierarchy

e Search for files or folders (displays the Search Companion)
e Display a list of Folders in a hierarchical "file tree"

e Change the View of the items in the right pane

You can also use My Computer as a Web browser by entering the URL for a Web page into the Address box. When you
enter an URL and press Enter, Windows connects to the Internet (if you're not already connected) and takes you to the
specified page.

Windows Explorer

In previous versions of Windows, Windows Explorer was a file-management tool that displayed files in a hierarchical
"tree." In Windows XP, however, Windows Explorer no longer exists. That is, there's no icon for it anywhere, and no
place for it on the Start menu.

That's because the old Windows Explorer hierarchical tree can now be displayed within My Computer. All you have to do
is click the Folders button on the My Computer toolbar. As you can see in Figure 3.2, the activity center pane slides out of
the way and is replaced with a "file tree" that lists all the devices, folders, and files on your system.

Many users prefer this hierarchical approach to managing folders and files because it gives you two panes worth of
folders and files to work with. The left Folders pane contains all the devices and folders on your system, in a tree-like
structure. The right pane displays the contents of any item selected in the Folders pane.

Figure 3.2 Change My Computer to look like Windows Explorer by displaying the Folders pane.
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Contents pane

In the Folders pane, drives or folders that contain other folders have a "+" beside them. Click the "+" to expand the
folders. When the drive or folder is fully expanded, the "+" changes to a "-"; click the "-" to collapse the contents again.

My Documents and Other Windows Folders

Windows XP tries to group related types of user files into master folders. Basic documents (for Word, Excel, and other
applications) are grouped into the My Documents folder. Image files are grouped into the My Pictures folder. MP3 and
other audio files are grouped into the My Music folder. Digital video files are grouped in the My Videos folder. And user-
created Web pages are grouped into the My Webs folder.

These upper-level Windows folders have several interesting things about them. First, they all look and act just like My
Computer—including the new activity center panes. Second, in addition to the standard Tasks list, some of these folders
(My Music and My Pictures, in particular) include an additional list of tasks specific to their type of files. Third, like My
Computer, you can choose to display a Folders pane instead of the normal activity center pane.

Let's look at My Documents first. Figure 3.3 shows a typical My Documents folder. In this screen shot, the subfolders
contained in My Documents are grouped by name. (I show you how to do this in the "Grouping Files and Folders" section
later in the chapter.) Select a folder and key details are displayed in the Details section of the activity center.

Figure 3.3 My Documents looks and acts just like My Computer, except that it displays key user-created files and
folders.
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Figure 3.4 shows another folder displayed from within My Documents. Here you can see how different files look, and
how the Tasks and Details sections of the activity center have adapted. In this view, My Documents is identical to My

Computer. (They really are the same tool!)

Figure 3.4 Individual files in the My Documents folder.
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Understanding Files and Folders

My Pictures, shown in Figure 3.5, is a subfolder of the My Documents folder. As you can see, image files are displayed as
thumbnails (instead of the typical boring file icons). A new Pictures Tasks section is in the activity center pane, and the
Details section also displays the selected thumbnail—along with key image information.

Figure 3.5 My Pictures is a variation of My Documents, specific to image files.
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TIP
For more information about My Pictures, see Chapter 11, "Working with Pictures."

The other upper-level folders (My Music, My Videos, and My Webs) are similar to My Pictures in that they're customized
for their specific types of files.

The Command Prompt

There's one more file-management tool in Windows XP that bears mentioning—even though it really isn't related to My
Computer and the other tools. This tool is the Command Prompt that you can use to execute old DOS commands.

Even though Windows XP isn't built on the MS-DOS engine (like Windows 9X/Me was), you still might have some old DOS
applications installed on your system. Or you may have learned how to use computer in those ancient pre-Windows
days, and can't quite give up that old command-line orientation. Whatever the case, XP still includes a DOS-emulation
utility for you to use.
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You access the Command Prompt by selecting Start, All Programs, Accessories, Command Prompt. As you can see in
Figure 3.6, the Command Prompt window looks pretty much like the old MS-DOS window in Windows 9X/Me, and works
pretty much the same way, too. You enter a DOS command at the prompt, and then press Enter. (To close the window,
just enter EXIT.)

You old-timers out there will be pleased to know that a good number of MS-DOS commands are still available in
Windows XP. Which means you can COPY and DEL and DIR to your heart's content.

Figure 3.6 It's still there—the Windows XP Command Prompt window.
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Configuring File and Folder Views

Leaving DOS behind (hopefully forever!), let's return to Windows XP's other file management tools. All these tools are
basically the same, and all can be customized in the same ways. You can change a lot about My Computer, My
Documents, and the other system folders, to create a truly personalized file management environment.

Activating Web View

If you can see the activity center pane in My Computer or My Documents, your version of Windows XP has Web View
turned on. Web View enables each folder to be displayed with custom HTML content, like you might see on the World
Wide Web. (The activity center pane is generated by HTML code, actually.) To take full advantage of Windows XP, you
definitely want to have Web View activated.

To turn Web View on or off, follow these steps:

1. From within any folder, select Tools, Options.
2. When the Folder Options dialog box appears, select the General tab (shown in Figure 3.7).

Figure 3.7 To use XP's activity centers, turn on Web View.
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Folder Options
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3. Inthe Web View section, check the Enable Web Content in Folders option.
4. Click OK.

In addition, activating Web View enables you to treat all file and folder icons as you would objects on a Web page.
Instead of double-clicking to launch an object, you can now single-click. Just select the Single-Click to Open an Object
option.

Changing the Way Files Are Displayed

You can choose to view the contents of a folder in a variety of ways. Just click the Views button and choose from the
following options:

e Thumbnails—Best for image files, as shown in Figure 3.8

e Tiles—Big icons with selected file details, shown in Figure 3.9

e |cons—Small icons with no file details, shown in Figure 3.10

e List—Filenames only with no details, shown in Figure 3.11

e  Details—Filenames only with selected details, shown in Figure 3.12
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Figure 3.8 Displaying files as thumbnails.
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Figure 3.9 Displaying files as tiles.
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Figure 3.10 Displaying files as icons.
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Figure 3.11 Displaying files in a list.
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Figure 3.12 Displaying files in a list with details.
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TIP

If you have moved, copied, or deleted some files and folders but don't see the changes, you need to update your display.
Select View, Refresh, or press the F5 key.

If you choose Details view, you can select which details are displayed. Select View, Choose Details to display the Detail
Settings dialog box. Check those settings you want to display, and use the Move Up and Move Down keys to place the
settings in the order you want. Click OK to lock in your new configuration.

Sorting Files and Folders

When viewing files in My Computer or My Documents, you can sort your files and folders in a number of ways. To do
this, select View, Arrange Icons By, and then choose from the following options:

e Name—Sorts files by filename, alphabetically

e  Size—Sorts files by size, smallest to largest

e  Type—Sorts files by file type: applications, configuration files, and so on
e Modified—Sorts files by date and time last modified
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TIP
You can also sort your icons by right-clicking in an open area of the folder and selecting Arrange Icons By.

If you're viewing your files in Details view, you can manually sort your files by any setting you've chosen to display. Just
click the top of a column to sort by that column. (Click the column a second time to reverse the order of the sort.)

Grouping Files and Folders

I'm not done with displaying files and folders just yet. Windows XP includes another option that | really like—the ability
to display files and folders in similar groups.

You've already seen what grouping looks like. My Computer groups items by device type, with a title and thin line above
each group. If you like this type of organization, you can apply similar grouping to any and all your folders.

To turn on grouping, select View, Arrange Icons By, and then check the Show In Groups option. Windows now groups
your files and folders by the criteria you used to sort those items. For example, if you sorted your files by date, they'll
now be grouped by date, as shown in Figure 3.13. (Actually, by Today, Last Week, Last Month, and so on.) If you sorted
your files by type, they'll be grouped by file type. And so on, for all the different ways of sorting your files.

Figure 3.13 Configure Windows XP to group your files by date, type, name, or size.
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Individual or Universal Views

The neat thing about selecting various views, sorts, and groups is that you can combine all these options in a lot of
different ways. For example you can display details sorted and grouped by date, or tiles sorted and grouped by file type.
However you want to view your files, you can.
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You need to know one more thing about all these different folder views. You can select different views for different
folders, or you can choose to apply a custom view to all your folders.

By default, when you customize a folder, that view is specific to that folder. To apply a folder view to all the folders on
your system, follow these steps:

1. Open the folder that looks the way you want it to look, and then select Tools, Options.
2. When the Folder Options dialog box appears, select the View tab (shown in Figure 3.14).

Figure 3.14 Make all your folders look like the current folder.
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3. Click the Like Current Folder button.
4. Click OK.

To return your folders to their default state, click the Reset All Folders button.

TIP
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While you're in the Folder Options dialog box, take a look at the Advanced Settings list on the View tab. As you can see,
this list contains a number of more obscure configuration settings, like hiding file extensions and displaying the full path
in the title bar. Remember this list if you need to change one of these settings.

Changing Folder Icons

You're not through customizing folders just yet. Windows XP also lets you change the icon used to represent a folder.
Just follow these steps:

1. From within the folder, select View, Customize This Folder.

When the Properties dialog box appears, select the Customize tab, shown in Figure 3.15.

3. Toselect a new icon for the folder, click the Change Icon button and select a new icon from the New Icon dialog
box.

4. Toselect a picture to use when this folder is displayed in thumbnail view, click the Choose Picture button and
browse to the desired image file. (If you don't choose a picture, up to four thumbnails from this folder's
documents are displayed.)

5. Click OK.

N
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Figure 3.15 Change the properties of the current folder, including the folder's icon.
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Personalizing the Send To Menu

With the advent of Windows XP's activity center pane, you'll probably find that you're doing less right-clicking. (In older
versions of Windows, you had to right-click to access many of the common tasks. These same tasks are now on the
activity center Tasks list.

That doesn't mean that you should give up right-clicking entirely. The pop-up menu that appears when you right-click a
file or folder still contains the Send To menu, which is one of the fastest ways to send a file from one place to another.
You can use the Send To menu to send a file to another disk, to another folder, to another user via e-mail, or to a printer
for printing.

Because using the Send To menu is a quick way to work with files, you might want to add other actions to the menu. For
example, you might want to create a Send To item for a Zip drive or commonly used folder. This way you can right-click a
file and use the Send To command to copy the file automatically.
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This is how you add options to the Send To menu:

1. Use My Computer to navigate to the \Documents and Settings\username\SendTo folder.

Select File, New, Shortcut.

3.  When the Create New Shortcut wizard appears, enter the name of the file, folder, or drive you want to add to
the Send To menu. (Click the Browse button to search your system for the item.) Click Next to proceed.

4. Enter the name you want to appear on the Send To menu, and then click Finish.

N

The next time you right-click a file and select Send To, your new item appears in the list of Send To options.

Because | use the Send To menu a lot, this is one of my favorite tips. | hope you can use it!

Basic Navigation and Operations

Now that you've looked at how to customize the look and feel of Windows XP's folders, let's turn our attention to some
basic drive and folder navigation and operations.

Navigate Disks and Folders
You can navigate through disks and folders My Computer, My Documents, and other folders in several ways:

e To view the contents of a disk or folder, click the selected item.

e To move up the hierarchy of folders to the next highest folder or disk, click the Up button on the toolbar.

e To move back to the disk or folder previously selected, click the Back button on the toolbar.

e To choose from the history of disks and folders previously viewed, click the down arrow on the Back button and
select a disk or folder. View the complete history by selecting the History icon on this pull-down menu.

e If you've moved back through multiple disks or folders, you can move forward to the next folder by clicking the
Forward button.

e  Godirectly to any disk or folder by entering the path in the Address Bar (in the format x:\folder\subfolder) and
pressing Enter or clicking the Go button.

You can also go directly to any folder by clicking the Folders button to display the Folders pane, and then selecting the
folder in the Folders list.

Selecting Files and Folders

Sometimes you want to perform an action on a single file. To select a single file, just hover your cursor over the file until
it is highlighted; the filename and icon changes color, and information about the selected file appears in the Details
section of the activity center pane. (If you're using double-click mode, you have to single-click a file to display the
Details.)

At other times, however, you want to perform a single action on multiple files. To select multiple files, hover your cursor
over the first file you want to select, and then hold down the Ctrl key on your keyboard. Select additional files by
hovering your cursor over them until they are highlighted. Keep holding down the Ctrl key until you've selected all
desired files.
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Creating Folders

Folders act kind of like drawers on your hard drive to hold other folders or files. They enable you organize your hard
drive by putting common files or subfolders together.

This is how you create new folders:

1. Navigate to the current drive or folder that contains the new folder.
2. Select File, New Folder—or click the Make a New Folder task in the File and Folder Tasks panel of the activity

center pane.
3. A new, empty folder appears, with the filename "New Folder" highlighted. Type a name for your folder (which
overwrites the "New Folder" name) and press Enter.

One of Microsoft's most important "little" changes is the addition of the "make new folder" command in so many places
within each folder window. Used to be you could only access this command from the File menu. Now you can create a
new file directly from the activity center pane, or by right-clicking anywhere in the folder window.

Thanks, Microsoft!
Finding Files

Locating a file on your system can be difficult, especially with today's extra-large hard disk drives. Windows XP includes a
new Search Companion utility that makes it relatively easy to find specific files on your system.

The Search Companion replaces the old Find utility, found in previous versions of Windows. Not only do you get the
companionship of an animated dog (named Rover), you also get some decent help and advice on how to fine-tune your
search.

Page 19 of 29



To search for a particular file, follow these steps:

1.

Search Companion

What do you want to search
for?

Pictures, music, or video

Documents {word
processing, spreadsheet,
etc.)

All files and folders
Computers or people

) Information in Help and
Support Center

You may also want to...
Q Search the Internet
Change preferences
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Open the Start menu and click the Search icon. (Alternately, you can click the Search button found on the
toolbar in any Windows folder.) This displays the Search Companion pane, as shown in Figure 3.16.

Figure 3.16 Use the new Search Companion to find files on your hard disk.

Select what type of file you want to search for. If you're not sure what file type to select, select All Files and
Folders.
The pane that appears next depends on which type of file you wanted to search for. In most cases, you can
choose to search by all or part of the filename, as well as choose where (what drive or folder) you want to look
for the file.
If available (and if relevant to your search), select one or more of the advanced search options, such as when
the file was last modified, or the file size.

Click the Search button to start the search.

The Search Companion now displays a list of files that meet your search criteria—along with advice on how to
refine the search. To narrow down your results, click one of the suggestions, and follow the onscreen advice.
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TIP

Just as you could with the old Find utility, you can use "wildcard" characters when searching with the Search Companion.
For example, if you use an asterisk(*) in place of multiple characters, searching for file* finds filename, filetype, and files.
If you use a question mark (?) in place of a single character, searching for file? finds only files.

By the way, you can change the animated character that appears in the Search Companion pane—or get rid of it
completely. To change the animated character, click the Change Preferences link and then click With a Different
Character. Windows XP comes with four characters built in.

To kill the Search Companion character, click the Change Preferences link and then click Without An Animated Screen
Character. Bye bye Rover!

Essential File Management

Now it's time to address the most common things you do with files—renaming, deleting, copying, and moving them.
Virtually all these activities can now be accessed directly from the activity center pane in any Windows folder.

Renaming Files and Folders

Naming your files and folders in a way that somehow describes their contents is a good idea. Sometimes, however, you
may need to change the name of a file or folder. Fortunately, it's relatively easy to rename an item.

CAUTION

Folder and filenames can include up to 255 characters—including many special characters. Some special characters,
however, are "illegal," meaning that you can't use them in folder or filenames. lllegal characters include the following: \ /
EN <>

To rename a file or folder, just follow these steps:

1. Select the file or folder you want to rename.

Click Rename This File from the File Tasks list (or Rename This Folder from the Folder Tasks list).

3. The filename is now highlighted. Type a new name for your folder (which overwrites the current name) and
press Enter.

N

TIP

A faster way to rename a file is to select the file and press F2 to automatically highlight the filename. (This is one of my
favorite tips!)

Deleting Files and Folders

Because disk space is a resource you don't want to waste, you should delete files and folders you no longer need.

1. Select the file or folder you want to delete.
2. Click Delete This File from the File Tasks list (or Delete This Folder from the Folder Tasks list).
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TIP

You can also delete a file by dragging it from the folder window onto the Recycle Bin icon on the desktop, or by
highlighting it and pressing the Del key.

Restoring Deleted Files

If you delete a file and later decide you made a mistake, you're in luck. For a short period of time, Windows XP stores
deleted files in a special file called the Recycle Bin. If you've recently deleted a file, it should still be in the Recycle Bin.

This is how you can restore a deleted file:

1. Open the Recycle Bin by clicking its icon on the desktop.
When the Recycle Bin opens (see Figure 3.17), select the file or folder you want to restore.
3. Click Restore This Item from the Recycle Bin Tasks list.

N

Figure 3.17 Bring a deleted file back to life from the Recycle Bin.
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Managing the Recycle Bin

The Recycle Bin is where deleted files are stored after you delete them. Files do not stay in the Recycle Bin indefinitely,
however.
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By default, the deleted files in the Recycle Bin can occupy 10 percent of your hard disk space. When you've deleted
enough files to exceed this 10 percent, the oldest files in the Recycle Bin are automatically and permanently deleted
from your hard disk.

If you want to manually remove files from the Recycle Bin, follow these steps:

1. Click the Recycle Bin icon on your desktop.

When the Recycle Bin opens, select Empty the Recycle Bin from the Recycle Bin Tasks list.

3.  When the Confirm File Delete dialog box appears, click Yes to completely erase the files, or click No to continue
storing the files in the Recycle Bin.

N

Copying Files and Folders
Copying a file or folder is how you place a copy of it at another location while still keeping the original where it is.

Copying is different from moving. When you copy an item, the original remains. When you move an item, the original is
no longer present in the original location.

This is how you copy a file or folder with Windows XP:

1. Select the file or folder you want to copy.

Click Copy This File from the File Tasks list (or Copy This Folder from the Folder Tasks list).

3.  When the Copy Items dialog box appears , navigate to and select the new location for the item, and then click
the Copy button. (If you want to copy the item to a new folder, click the New Folder button first.)

N

TIP

You can copy a file in several other ways. You can select the file and then select File, Copy to Folder. You can right-click it
and select Send To from the pop-up menu. You can hold down the Ctrl key and drag it from one location to other. You
can even drag the file with the right mouse button—when you drop the file into a new location, you see a pop-up menu
that asks whether you want to move it or copy it.

Moving Files and Folders

Moving a file or folder is different from copying it. Moving cuts the item from its previous location and places it in a new
location. Copying leaves the original item where it was and creates a copy of the item elsewhere.

In other words, when you copy something you end up with two of it. When you move something, you only have the one
thing.

To move a file or folder, follow these steps:

1. Select the file or folder you want to move.

Click Move This File from the File Tasks list (or Move This Folder from the Folder Tasks list).

3. When the Move Items dialog box appears, navigate to and select the new location for the item, and then click
the Copy button. (If you want to move the item to a new folder, click the New Folder button first.)

N

TIP
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You can move a file several other ways. You can select the file and then select File, Move to Folder. You can drag the file
from one location to another. You can even do the right-drag trick discussed earlier. When you drop the file into a new
location, you see a pop-up menu that asks whether you want to move it or copy it.

Unprotecting Read-Only Files
If you have a file that you want to edit or delete but you can't, chances are the file is designated as read-only.
Read-only files can't be changed or deleted. You can read these files, but you can't touch them.

If you need to edit or delete a read-only file, you need to change that file's attributes—such as whether it's hidden, or
read-only. Follow these steps:

1. Select the file or folder you want to change and select File, Properties.

2.  When the Properties dialog box appears (see Figure 3.18), select the General tab and then check or uncheck the
desired attributes. For example, to make a read-only file editable, uncheck the Read-only check box.

3. After you've made the desired changes, click the OK.

Figure 3.18 You can change the attributes of a file from the Properties dialog box.

Where did my files go Properties

General |

= | Where did my files go |

Type of file:  Text Document

Opens with: [, Notepad Change... ]
Location: C:'\Documents and Settings\default\My Document:
Size: 1.09 KB (1,126 bytes)

Size ondisk:  16.0 KB (15,384 bytes)

Created: Thursday, July 12, 2001, 11:57:23FM
Modified: Thursday, July 12, 2001, 11:57:24FPM

Accessed: Thursday, July 12, 2001

Attributes: [ |Read-only []Hidden Archive

[ [8].4 H Cancel ]
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You can change the following file attributes in the Properties dialog box:
e Read-only files are files you can read but not edit or delete.

e Hidden files are files—typically sensitive system files—that you normally can't view from My Computer.
e Archive files are files that have changed since last backed up.

Compressing and Decompressing Files

Files are getting bigger.

If you want to transfer a really big file to another computer, you can run into all sorts of problems. If you're copying the
file to floppy disk, the file might be too big to fit on a single floppy disk. If you're sending the file via e-mail, the file might
be so big it exceeds your ISP's limits on attachment size.

No matter how you look at it, big files are a bother.

Fortunately, Windows XP includes a way to make big files smaller. Compressed folders take big files and compress them
down in size, which makes them easier to copy or move. After the file has been transferred, you uncompress the file
back to its original state.

Compressing a File

Compressing a file is a relatively easy task from within any Windows folder. You can even compress multiple files into a
single compressed folder.

Just follow these simple steps:

1. Select the file(s) you want to compress.
2. Right-click the selected file(s) and select Send To, Compressed Folder.

That's it—that's all you have to do! Windows creates a new folder, such as the one in Figure 3.19, that contains
compressed versions of the file(s) you selected. You can now copy, move, or e-mail this folder, which is a lot smaller than
the original file(s).

Figure 3.19 A compressed folder—notice the little "zipper" on the folder icon.

| | WindowsXP-Final
ci KR

The compressed folder is actually a file with a .ZIP extension, so it can be used with other compression/decompression
programs, such as WinZip. You can add files to a compressed folder by dragging and dropping them onto the compressed
folder icon.

CAUTION
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If you install a third-party Zip program on your system, Windows removes Compressed Folders from the Send To menu
and replaces it with a link to the new compression program.

One thing to keep in mind about XP's compressed folders. While the Extraction Wizard can extract multiple-disk .ZIP files,
Windows XP cannot create multiple-disk files. If you need to create a compressed folder that's too big to fit on a single
floppy disk, you have to use a third-party utility, such as WinZip. (By the way, you can download WinZip from
http://www.winzip.com.)

TIP

To better identify compressed folders, you can configure Windows XP to display them in blue. Just open the Folder
Options dialog box, select the View tab, and check the "Display compressed files and folders with alternate color options.

Extracting Files

The process of decompressing a file is actually an extraction process. That's because you extract the original file(s) from
the compressed folder.

In Windows XP, this process is eased by the use of the Extraction Wizard. This is how it works:

1. Right-click the compressed folder and select Extract All.

When the Extraction Wizard launches, click the Next button.

3. When the Select a Destination page appears, select which folder you want to extract the files to, and then click
the Next button.

4. The wizard now extracts the files, and displays the Extraction Complete page. Click the Finish button.

N

NOTE

If the compressed folder comprised a multiple-disk set, the Extraction Wizard prompts you to insert each disk in the set,
as needed.

Working with File Types and Associations

As you browse the files and folders on your system, you notice that some files have specific icons. These icons enable
you know what type the file is. The file type determines more than just the icon, however. It also determines the
application that is used to open the file.

Displaying or Hiding File Types

Windows XP can (and does) hide certain types of files—specifically sensitive system files. Because you don't want to
accidentally delete or change a system file, hiding these files is probably a good idea.

You may, however, run into a situation where you need to edit one of these system files. If this happens to you, you
need to know how to unhide the file.

To unhide all the hidden files on your system, follow these steps:

1. From the Control Panel, click the Folder Options icon.
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When the Folder Options dialog box appears, select the View tab.
Open the Hidden Files and Folders item and check the Show Hidden Files and Folders option.
Click OK to register your changes.

Associating a File Type with an Application

When you install a new application, it usually registers its file types automatically. That is, Windows associates that file
type with a specific application. You may also need to reassociate a file type, however, if you install a new program that
hijacks the original file associations for itself—and you'd rather go back to the default associations.

To associate a file type with a particular application, follow these steps:

N

From the Control Panel, click the Folder Options icon.

When the Folder Options dialog box appears, select the File Types tab and click the Change button.

When the Open With dialog box appears, select the application you want to associate with the file type. (If the
program you want isn't listed, click the Click Here link to search for and select another program.)

Click OK.

Changing Icons for File Types

Each file type is represented by a specific icon. If you don't like a particular icon, you can easily choose another icon for
any file type.

Follow these steps:

N

From the Control Panel, click the Folder Options icon.

When the Folder Options dialog box appears, select the File Types tab.

Choose the file type you want to change from the Registered File Types list, and then click the Advanced
button.

When the Edit File Type dialog box appears, click the Change Icon button.

When the Change Icon dialog box appears (see Figure 3.20), select a new icon or click the Browse button to
choose an icon from another file.

Click OK to register your change.
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Figure 3.20 Change the icon associated with a particular file type.

Change Icon

Look for icons in this file:

| |[ Browse... ]

Select an icon from the list below:
SE
)

oK l [ Cancel

Removing File Types

Sometimes you find file types registered that don't even exist on your system. This can happen after you uninstall a
program and its associated files. Do not do this unless you know what you are doing.

To clean up your system by removing unused file types, follow these steps:

1. From the Control Panel, click the Folder Options icon.
2. When the Folder Options dialog box appears, select the File Types tab.
3. Choose the file type you want to remove from the Registered File Types list, and then click the Remove button.
4. Click OK.
Top Ten Tips

When you're working with files and folders, these are the ten most important things to remember:

1. Use My Computer to manage all the drives and devices attached to your system. Use My Documents to manage
your documents.

2.  When Web View is activated, My Computer and other folders display an activity center pane. This pane
contains a context-sensitive Tasks list that makes it easy to perform most common file operations.

3. In Windows XP, My Computer, My Documents, and other system folders are all essentially the same tool.

4. Since Windows Explorer has been removed from Windows XP, you can display a "file tree" view by clicking the
Folders button in My Computer or My Documents.
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5. The My Pictures and My Music folders are customized with views and commands useful for their specific types
of files.

6. Windows XP lets you display different icon views, and group icons by type, date, size, or name.

7. The fastest way to copy a file is to right-click the file and select Send To from the pop-up menu.

8. If you right-drag a file to a new location, Windows displays a pop-up menu that lets you choose to either copy
or move the file.

9. Allfiles you delete are sent to the Recycle Bin folder. Until the Recycle Bin is filled up, you can restore any file
you've recently deleted.

10. To reduce the size of files you want to copy or e-mail, used Windows XP's compressed folders feature—which
creates compressed .ZIP files.
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